Quick Start to Stand-Alone Installation

This section provides step-by-step instructions about how to install AutoCAD Land Desktop 2009 on your system. You should read the entire Stand-Alone Installation Guide if you have any questions that are not addressed in this Quick Start section.

This guide applies to both versions of the Land Desktop product (AutoCAD Land Desktop 2009 and AutoCAD Civil 3D Land Desktop Companion 2009).

For information about installing network-licensed or multi-seat stand-alone versions of the program, see the AutoCAD Land Desktop Network Administrator’s Guide.

Topics in this section

- How to Prepare for Installation
- How to Install AutoCAD Land Desktop
- How to Register and Activate AutoCAD Land Desktop
- How to Launch AutoCAD Land Desktop 2009
- How to Install AutoCAD Land Desktop with Civil 3D
- How to Install and Start the CAD Manager Control Utility

Please send us your comment about this page
Quick Start to Stand-Alone Installation >

How to Prepare for Installation

Before you install AutoCAD Land Desktop, you need to review the system requirements, understand administrative permission requirements, locate your AutoCAD Land Desktop 2009 serial number, and close all running applications.

If you are installing AutoCAD Civil 3D Land Desktop Companion 2009, the civil engineering tool features and the survey tool features are automatically installed with the product. If you are installing AutoCAD Land Desktop 2009, the civil engineering tool features and the survey tool features are not included with the product. The installation procedure is the same whether you are installing AutoCAD Civil 3D Land Desktop Companion 2009 or AutoCAD Land Desktop 2009.

Note In this guide, mentions of AutoCAD Land Desktop refer to both AutoCAD Land Desktop 2009 and AutoCAD Civil 3D Land Desktop Companion 2009 unless otherwise noted.

Topics in this section

- How to Review System Requirements
- How to Understand Administrative Permission Requirements
- How to Install Multiple or Bundled Products
- How to Locate Your AutoCAD Land Desktop Serial Number
- How to Avoid Data Loss During Installation

Please send us your comment about this page
Quick Start to Stand-Alone Installation > How to Prepare for Installation >
How to Review System Requirements

Make sure that the computer on which you install AutoCAD Land Desktop meets the system requirements. If your system does not meet the system requirements, many problems can occur, both within AutoCAD Land Desktop and at the operating system level.

See System Requirements.
To install AutoCAD Land Desktop, you must have administrator permissions. You do not need to have domain administrative permissions. See your system administrator for information about administrative permissions.

To run AutoCAD Land Desktop, you do not need administrator permissions. You can run the program as a limited user.
Some Autodesk packages are comprised of multiple products or are part of *multi-product bundles*.

In the Installation wizard for packages containing multiple products, you can choose which products you want to install. During the install process, you are informed whether a copy of the software is already installed. You are also warned if your system does not meet the minimum system requirements for the product. Each product name is displayed on its own tabbed panel; you can configure products individually.

If you purchased a package that is a multi-product bundle, such as an educational or institutional package, you may have a package that includes several Autodesk products. For these bundled packages, an installation disk contains information for all the products in the package.
How to Locate Your AutoCAD Land Desktop Serial Number

When you activate AutoCAD Land Desktop, you are prompted for your serial number. Your serial number is located on the outside of the product package. Make sure to have this number available before you activate the program so that you don't have to stop in the middle of the installation.
The AutoCAD Land Desktop installation process may stop if some applications (such as Microsoft® Outlook® or anti-virus programs) are running. Close all running applications to avoid possible data loss.
AutoCAD Land Desktop ships on a single DVD. The installation process has been streamlined by means of the Installation wizard.

1. Insert the AutoCAD Land Desktop DVD.

2. In the AutoCAD Land Desktop Installation wizard, click Install Products.

3. Follow the directions on each installation page.
   
   **Note** When you select Install without making any changes, the Installation wizard asks you to confirm you want to continue installing using the default configuration. If you select Yes, a Typical installation takes place. See Install AutoCAD Land Desktop.
Quick Start to Stand-Alone Installation

How to Register and Activate AutoCAD Land Desktop

After AutoCAD Land Desktop is installed, you can initiate the registration process by launching the product. When you launch AutoCAD Land Desktop, the Product Activation wizard is displayed. Follow the directions in the Product Activation wizard to register the product.

Have your product serial number available to be able to register and activate AutoCAD Land Desktop.

**Note** If you are upgrading from an earlier release of AutoCAD Land Desktop, use your new serial number when you register and activate the new release.

See [Register and Activate AutoCAD Land Desktop](#).
How to Launch AutoCAD Land Desktop 2009

Assuming that you followed all of the previous steps, you can launch AutoCAD Land Desktop. For more information about the new features, see the New Features Workshop after you launch the product.

You can start AutoCAD Land Desktop from:

- **Desktop shortcut icon.** When you install AutoCAD Land Desktop, an AutoCAD Land Desktop 2009 shortcut icon is created on your desktop unless you cleared that option during installation. Double-click the AutoCAD Land Desktop 2009 icon to start AutoCAD Land Desktop.

- **Start menu.** Click Start menu ➤ All Programs (or Programs) ➤ Autodesk ➤ AutoCAD Land Desktop 2009 ➤ AutoCAD Land Desktop 2009.

- **Location where AutoCAD Land Desktop is installed.** If you have administrative permissions, you can run AutoCAD Land Desktop in the location where you installed it.

  If you are a limited-rights user, you must run AutoCAD Land Desktop from the Start menu or from the desktop shortcut icon. If you want to create a custom shortcut, make sure that the Start In directory for the shortcut points to a directory where you have write permissions.

---

**Please send us your comment about this page**
Quick Start to Stand-Alone Installation >

How to Install AutoCAD Land Desktop with Civil 3D

If you plan to install AutoCAD Civil 3D Land Desktop Companion 2009 and AutoCAD Civil 3D 2009 on the same system, it is recommended that you install AutoCAD Civil 3D first, and then install AutoCAD Civil 3D Land Desktop Companion 2009. You can also install AutoCAD Civil 3D on a system with AutoCAD Civil 3D Land Desktop Companion 2009 already installed.

If you encounter installation problems, run the Repair utility on the application that is experiencing the problem (see Reinstall or Repair AutoCAD Land Desktop). For example, you may need to run the Repair utility on AutoCAD Civil 3D if you installed it after installing AutoCAD Civil 3D Land Desktop Companion 2009.

Please send us your comment about this page
Quick Start to Stand-Alone Installation

How to Install and Start the CAD Manager Control Utility

Using the Autodesk CAD Manager Control utility, CAD managers can selectively control which users have access to Internet-based content and information from DesignCenter Online, Communication Center, and the Subscription Center. They can also determine if users receive notification when reported errors are resolved.

To install the CAD Manager Control utility

1. Insert the product DVD.
2. In the Installation wizard, click Install Tools and Utilities.
3. On the Select the Products to Install page, select Autodesk CAD Manager Tools, click Next.
4. Review the Autodesk software license agreement for your country or region. You must accept this agreement to proceed with the installation. Select your country or region, click I Accept, and then click Next.  
   Note If you do not agree to the terms of the license and want to terminate the installation, click Cancel.
5. On the Review - Configure - Install page, click Install if you want to accept the default install location.  
   The Installation wizard asks you to reconfirm that you want to continue installing using the default configuration.
   If you want the utility installed in a different installation path, click Configure, set the path, click Configuration Complete and then Install.
6. When the Installation Complete page is displayed, click Finish.

To start the CAD Manager Control utility
1. Click Start menu ➤ All Programs (or Programs) ➤ Autodesk ➤ CAD Manager Tools ➤ CAD Manager Control Utility.

2. Select the product you want to modify. Click OK.

Please send us your comment about this page
If you have a previous version of AutoCAD Land Desktop installed on your system, you can install AutoCAD Land Desktop 2009 and keep other versions of the program on the same system. This is called a *side-by-side* installation. If you've purchased an *upgrade* version of AutoCAD Land Desktop, you are required to uninstall the previous version within 120 days of installing AutoCAD Land Desktop 2009. See your license agreement for more information.

In this section, you learn about locating customized files.

**Topics in this section**

- [Removal of Power User Requirements for Using AutoCAD Land Desktop](#)
- [Locate Customized Files](#)

---

Please send us your comment about this page
Locating AutoCAD Land Desktop 2009 Customized Files

Removal of Power User Requirements for Using AutoCAD Land Desktop

In AutoCAD Land Desktop 2004, you were required to have power user rights to run AutoCAD Land Desktop. This requirement no longer exists, and you can now run AutoCAD Land Desktop as a limited user. You can access and create your own customizable files in the Documents and Settings folder. To install AutoCAD Land Desktop 2009, you must have administrative permissions. See your system administrator for information about administrative permissions.

**Note** If you are a limited user, you run AutoCAD Land Desktop 2009 from the Start menu or from the desktop shortcut icon. If you want to create a custom shortcut, make sure that the Start In directory for the shortcut points to a directory where you have write permissions. As a limited user, you cannot run AutoCAD Land Desktop 2009 from the folder where it is installed (for example, `c:/Program Files/AutoCAD Land Desktop 2009/acad.exe`).

Please send us your comment about this page
In AutoCAD Land Desktop 2004 and continuing in AutoCAD Land Desktop 2009, the location of some of the customized files has changed to allow for:

- **Limited user rights on a workstation.** You can run AutoCAD Land Desktop as a limited user. This means that you no longer need power user or Administrator permissions to run AutoCAD Land Desktop once it is installed.

- **Roaming profiles.** Roaming profiles allow you to log on to any computer within a network and retain your user settings. Some files, such as your personal settings and documents, follow you from computer to computer, while other files, such as templates (including Publish to Web templates), reside only on your system.

  If roaming profiles are allowed on your network, your “roamable” files are located in the `\Application Data\Autodesk\<Product Version>` folder, and your “nonroamable” files are located in the `\Local Settings\Application Data\Autodesk\<Product Version>` folder.

*Note* In some operating systems, the folders that are located under your profile are hidden by default. To display these files, you may need to change your display settings. On the Start menu, click Control Panel > Folder Options. In the Folder Options dialog box, on the View tab, click Show Hidden Files and Folders.

**Topics in this section**

- [Locate Data Link Files](#)
- [Locate Plot Style Files](#)
- [Locate Plotter Files](#)
- [Locate the PMP File](#)
- Locate Support Files
- Locate Drawing Template Files
- Locate Texture Files

Please send us your comment about this page
In AutoCAD Land Desktop 2004 and continuing in AutoCAD Land Desktop 2009, the default location of your data link files has changed. For information about the default location of these files, see Locate Customized Files.

**Note** In some operating systems, the folders that are located under your profile are hidden by default. To display these files, you may need to change your display settings. On the Start menu, click Control Panel > Folder Options. In the Folder Options dialog box, on the View tab, click Show Hidden Files and Folders.

**To locate your data link files**

1. In AutoCAD Land Desktop, at the command line, enter options.

2. In the Options dialog box, Files tab, expand Data Sources Location.

3. Under Data Sources Location, click the path name to view the location of your data link files.

   **Note** The changes you make do not take effect until you restart the program.

---

**Please send us your comment about this page**
In AutoCAD Land Desktop 2004 and continuing in AutoCAD Land Desktop 2009, the default location of your plot style files has changed. For information about the default location of these files, see Locate Customized Files.

**Note** In some operating systems, the folders that are located under your profile are hidden by default. To display these files, you may need to change your display settings. On the Start menu, click Control Panel ➤ Folder Options. In the Folder Options dialog box, on the View tab, click Show Hidden Files and Folders.

**To locate your plot style files**

1. In AutoCAD Land Desktop, at the command line, enter `options`.
2. In the Options dialog box, Files tab, expand Printer Support File Path.
3. Expand Plot Style Table Search Path file.
4. Under Plot Style Table Search Path, click the path name to view the location of your plot style files.

**Note** You can also locate your plot style files by entering `stylesmanager` at the AutoCAD Land Desktop command line.
In AutoCAD Land Desktop 2004 and continuing in AutoCAD Land Desktop 2009, the default location of your plotter files has changed. For information about the default location of these files, see Locate Customized Files.

**Note** In some operating systems, the folders that are located under your profile are hidden by default. To display these files, you may need to change your display settings. On the Start menu, click Control Panel ➤ Folder Options. In the Folder Options dialog box, on the View tab, click Show Hidden Files and Folders.

**To locate your plotter files**

1. In AutoCAD Land Desktop, at the command line, enter options.
2. In the Options dialog box, Files tab, expand Printer Support File Path.
3. Expand Printer Configuration Search Path.
4. Under Printer Configuration Search Path, click the path name to view the location of your plotter files.

**Note** You can also locate your plotter files by entering **plottermanager** on the AutoCAD Land Desktop command line.
In AutoCAD Land Desktop 2004 and continuing in AutoCAD Land Desktop 2009, the default location of your PMP file has changed. For information about the default location of this file, see Locate Customized Files.

*Note* In some operating systems, the folders that are located under your profile are hidden by default. To display these files, you may need to change your display settings. On the Start menu, click Control Panel > Folder Options. In the Folder Options dialog box, on the View tab, click Show Hidden Files and Folders.

**To locate your PMP file**

1. In AutoCAD Land Desktop, at the command line, enter options.
2. In the Options dialog box, Files tab, expand Printer Support File Path.
3. Under Printer Description File Search Path, click the path name to view the location of your PMP file.

---

Please send us your comment about this page
In AutoCAD Land Desktop 2004 and continuing in AutoCAD Land Desktop 2009, the default location for some of your support files has changed. For information about the default location of these files, see Locate Customized Files.

Support files include the following:

- Configuration file (acad2009.cfg)
- Customization file (acad.cui)
- Custom icon files
- Help and miscellaneous files
- Font mapping file (acad.fmp)
- Alternate font file (simplex.shx)
- Support path files (acad.dcl, acad.lin, acad.mnl, acad.pat, acad.pgp, acad.psf, acad.unt, acadiso.lin, acadiso.pat, ase.dcl, base.dcl, dbcon.cui, doshelp.dcl, and gdt.shx)

**Note** In some operating systems, the folders that are located under your profile are hidden by default. To display these files, you may need to change your display settings. On the Start menu, click Control Panel > Folder Options. In the Folder Options dialog box, on the View tab, click Show Hidden Files and Folders.

**To find the default location of the configuration file**

1. In AutoCAD Land Desktop, at the command line, enter `options`.

2. In the Options dialog box, Files tab, expand Help and Miscellaneous File Names.
3. Expand Configuration File.
4. Under Configuration File, click the path name to view the location of your configuration file.

**To find the default location of the customization files**

1. In AutoCAD Land Desktop, at the command line, enter `options`.
2. In the Options dialog box, Files tab, expand Customization Files.
3. Expand Main Customization File.
4. Under Main Customization File, click the path name to view the location of your main customization file.
5. Expand Enterprise Customization File.
6. Under Enterprise Customization File, click the path name to view the location of your enterprise customization files.

*Note* By default, the path to an enterprise customization file is empty until you define the file. For more information about defining a customization file, see “Customize the User Interface” in the *Customization Guide*.

**To find the default location of the custom icon files**

1. In AutoCAD Land Desktop, at the command line, enter `options`.
2. In the Options dialog box, Files tab, expand Customization Files.
3. Under Custom Icon Location, click the path name to view the location for the custom button image files used with your customization files.

**To find the default location of the Help and miscellaneous files**

1. In AutoCAD Land Desktop, at the command line, enter `options`.
2. In the Options dialog box, Files tab, expand Help and Miscellaneous File Names.
3. Expand the file you want to locate, and then click the path name to view the location of the files.

**To find the default location of the font mapping file**
1. In AutoCAD Land Desktop, at the command line, enter `options`.

2. In the Options dialog box, Files tab, expand Text Editor, Dictionary, and Font File Names.


4. Under Font Mapping File, click the path name to view the location of your font mapping file.

**To find the default location of the alternate font file**

1. In AutoCAD Land Desktop, at the command line, enter `options`.

2. In the Options dialog box, Files tab, expand Text Editor, Dictionary, and Font File Names.

3. Expand Alternate Font File.

4. Under Alternate Font File, click the path name to view the location of your alternate font file.

**To find the default location of the support path files**

1. In AutoCAD Land Desktop, at the command line, enter `options`.

2. In the Options dialog box, Files tab, expand Support File Search Path.

3. Under Support File Search Path, click a path name to view the location of your support files.
Beginning with AutoCAD Land Desktop 2004, the default location of your drawing template files has changed. For information about the default location of these files, see Locate Customized Files.

**Note** In some operating systems, the folders that are located under your profile are hidden by default. To display these files, you may need to change your display settings. On the Start menu, click Control Panel ➤ Folder Options. In the Folder Options dialog box, on the View tab, click Show Hidden Files and Folders.

**To locate your drawing template files**

1. In AutoCAD Land Desktop, at the command line, enter `options`.
2. In the Options dialog box, Files tab, expand Template Settings.
3. Under Template Settings, expand Drawing Template File Location.
4. Under Drawing Template File Location, click the path name to view the location of your drawing template files.

---

Please send us your comment about this page
Beginning with AutoCAD Land Desktop 2004, the default location of your texture files has changed. For information about the default location of these files, see Locate Customized Files.

**Note** In some operating systems, the folders that are located under your profile are hidden by default. To display these files, you may need to change your display settings. On the Start menu, click Control Panel ➤ Folder Options. In the Folder Options dialog box, on the View tab, click Show Hidden Files and Folders.

**To locate your texture files**

1. In AutoCAD Land Desktop, at the command line, enter `options`.
2. In the Options dialog box, Files tab, expand Texture Maps Search Path.
3. Under Texture Maps Search Path, click the path name to view the location of your texture files.

Please send us your comment about this page
Install Autodesk Products for an Individual User

This section provides instructions for installing and activating your Autodesk products for an individual user on a stand-alone computer. For information about installing network-licensed or multi-seat stand-alone versions of the program, see the *Network Administrator's Guide*, located on the Documentation tab of the Installation wizard and in the Help system.

The process for installing AutoCAD Civil 3D Land Desktop Companion 2009 is the same as the process for installing AutoCAD Land Desktop 2009.

**Topics in this section**

- [The AutoCAD Land Desktop 2009 Installation Wizard](#)
- [System Requirements](#)
- [Install AutoCAD Land Desktop](#)
- [Register and Activate AutoCAD Land Desktop](#)
- [Add or Remove Features](#)
- [Reinstall or Repair AutoCAD Land Desktop](#)
- [Uninstall AutoCAD Land Desktop](#)
- [Features that Require Autodesk Design Review](#)
The AutoCAD Land Desktop Installation wizard contains all installation-related material in one place. From the Installation wizard, you can access user documentation, install the product and supplemental tools, view support solutions, and learn about deploying your product on a network.

**Note** AutoCAD Land Desktop ships on a single DVD. Insert the AutoCAD Land Desktop 2009 DVD to start the installation process. Follow the prompts to complete the installation. As long as the DVD is in the drive, you can access documentation by clicking the documentation link.

- **Review installation documentation before you install.** You can access system requirements, the *AutoCAD Land Desktop Stand-Alone Installation Guide*, and the *Readme.chm* file before you install your product. Click the Read the Documentation link and click a document you want to view.

- **Install AutoCAD Land Desktop.** From the Installation wizard, click Install Products. Follow the on-screen instructions to complete the installation.
Before you install your product on a stand-alone computer, make sure that your computer meets the minimum system requirements.

**Note** The system requirements for installing AutoCAD Civil 3D Land Desktop Companion 2009 are the same as those for installing AutoCAD Land Desktop 2009.

<table>
<thead>
<tr>
<th>Hardware/Software</th>
<th>Requirement</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td><strong>32-Bit</strong></td>
<td>It is recommended that non-English language versions of AutoCAD Land Desktop be installed on an operating system with a user interface language that matches the code page of the AutoCAD Land Desktop language. A code page provides support for character sets used in different languages.</td>
</tr>
<tr>
<td></td>
<td>Windows Vista Enterprise</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows Vista Business</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows Vista Ultimate</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows Vista Home Premium</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows XP Professional, Service Pack 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The 64-bit versions of Windows XP and Windows Vista are</td>
<td></td>
</tr>
</tbody>
</table>
supported only in the 32-bit compatibility mode.

<table>
<thead>
<tr>
<th>Web browser</th>
<th>32-bit</th>
<th>You cannot install AutoCAD Land Desktop if Microsoft Internet Explorer 6.0 with Service Pack 1 (or later) is not installed on the installation workstation. You can download Internet Explorer from: <a href="http://www.microsoft.com/downloads/">http://www.microsoft.com/downloads/</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>32-bit</td>
<td>Intel® Pentium® 4, 3.0 GHz or faster, AMD® Athlon™, 2.0 GHz or faster, or Intel or AMD Dual Core processor, 1.6 GHz or faster</td>
</tr>
<tr>
<td>RAM</td>
<td>32-bit</td>
<td>1 GB</td>
</tr>
</tbody>
</table>
| Graphics card | 1280 x 1024 32-bit color video display adapter (True Color) 128 MB or greater, OpenGL®- or Direct3D®-capable, workstation class graphics card. For Windows Vista, | - Requires a Windows-supported display adapter.  
- For graphics cards that support Hardware Acceleration, DirectX 9.0c, or later, must be installed.  
- Installing from the \texttt{LDT.msi} file does not install DirectX 9.0c, or later. Manual installation of DirectX is |
<table>
<thead>
<tr>
<th>Requirement</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>a Direct3D-capable workstation class graphics card with 128 MB or greater is required.</td>
<td>1024 x 768 VGA with True Color (minimum) required, in this circumstance, for Hardware Acceleration to be configured.</td>
</tr>
<tr>
<td>Hard disk</td>
<td>2 GB</td>
</tr>
<tr>
<td>Pointing device</td>
<td>Mouse, trackball, or other device</td>
</tr>
<tr>
<td>DVD-ROM</td>
<td>Any speed (for installation only)</td>
</tr>
<tr>
<td>Optional hardware</td>
<td>Printer or plotter</td>
</tr>
<tr>
<td>Optional hardware</td>
<td>Digitizer</td>
</tr>
<tr>
<td>Optional hardware</td>
<td>Modem or access to an Internet connection</td>
</tr>
<tr>
<td>Optional hardware</td>
<td>Network interface card</td>
</tr>
</tbody>
</table>

**Note** Adobe Flash Player is no longer installed by default. If a suitable version of Flash is not currently installed on your system, a message is displayed requesting that you download it from Adobe’s website. If you do not have Internet access, you can also access the Flash installer on the AutoCAD Land Desktop product media.

---

Please send us your comment about this page
This section contains information for installing AutoCAD Land Desktop on a stand-alone computer. You must have administrative permissions to install AutoCAD Land Desktop 2009.

Insert the AutoCAD Land Desktop 2009 DVD to start the installation process. Follow the prompts to complete the installation.

**Note** When you install AutoCAD Land Desktop 2009, the AutoCAD Land Desktop startup accelerator (acstart17.exe) is automatically installed. With the startup accelerator, AutoCAD Land Desktop 2009 can start faster the first time it is run. If you do not want the accelerator to run at startup, you can turn it off. To turn off the accelerator, on the Start menu (Windows), click All Programs (or Programs) ➤ Startup. Then right-click AutoCAD Land Desktop Startup Accelerator and click Delete.

**To install AutoCAD Land Desktop using default values on a stand-alone computer**

This is the fastest means of installing AutoCAD Land Desktop on your system. Only default values are used for the typical installation, and the program files are installed to `C:\Program Files\AutoCAD Land Desktop 2009`. The text editor defaults for Windows Notepad and Express Tools are included.

1. Insert the AutoCAD Land Desktop 2009 DVD.

2. In the AutoCAD Land Desktop Installation wizard, click Install Products.

3. Select the products to install and click Next.

   **Note** Autodesk Design Review 2009 is not installed by default when you install AutoCAD Land Desktop. Some AutoCAD Land Desktop features require that Autodesk Design Review be installed to work properly.
Design Review is the replacement viewer for Autodesk DWF Viewer. For more information about the affected features, see Features that Require Autodesk Design Review.

4. Review the Autodesk software license agreement for your country or region. You must accept this agreement to proceed with the installation. Choose your country or region, click I Accept, and then click Next.  
   **Note** If you do not agree to the terms of the license and want to terminate the installation, click Cancel.

5. On the Products and User Information page, enter your serial number and user information and click Next.  
   **Important** The information you enter here is permanent and is displayed in the AutoCAD Land Desktop window (accessed by Menu browser ➤ Help ➤ About) on your computer. Because you can't change this information later without uninstalling the product, make sure you enter the correct information now.

6. If you do not wish to make configuration changes on the Review - Configure - Install page, click Install. Then click Yes to continue installing using the default configuration.  
   The wizard does the following:
   - Uses a typical installation, which installs the most common application features.
   - Includes the Express Tools library of productivity tools that extend the power of AutoCAD Land Desktop.
   - Installs AutoCAD Land Desktop to the default install location of C:\Program Files\AutoCAD Land Desktop 2009.

**To install AutoCAD Land Desktop using configured values on a stand-alone computer**

You can fine-tune exactly what gets installed by using the Configure option. You can alter the installation type, the install path, license type, and the default text editor. You can also choose to install material libraries.

   1. Insert the AutoCAD Land Desktop 2009 DVD.
2. In the AutoCAD Land Desktop Installation wizard, click Install Products.

3. Select the product(s) you want to install and click Next.

4. Review the Autodesk software license agreement for your country or region. You must accept this agreement to proceed with the installation. Choose your country or region, click I Accept, and then click Next.
   
   Note If you do not agree to the terms of the license and want to terminate the installation, click Cancel.

5. On the Products and User Information page, enter your user information and click Next.
   
   Important The information you enter here is permanent and is displayed in the AutoCAD Land Desktop window (accessed by Menu browser ➤ Help ➤ About) on your computer. Because you can't change this information later without uninstalling the product, make sure you enter the correct information now.

6. On the Review - Configure - Install page, click Configure to make configuration changes such as installation type, installing optional tools, or changing the installation path.

7. On the Select the License Type page, you can choose to install a Stand-alone or Network license. Click Next.

8. On the Select the Installation Type page, you can choose to make the following configuration changes:

   - Typical - Installs the most common application features.
   - Custom - Installs only the application features that you select from the Select Features To Install list:

<table>
<thead>
<tr>
<th>CAD Standards</th>
<th>Contains tools for reviewing design files for compliance with your standards.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>Contains database access tools.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dictionaries</td>
<td>Contains multi-language dictionaries.</td>
</tr>
<tr>
<td>Drawing Encryption</td>
<td>Allows you to use the Security Options dialog box to protect a drawing with a password.</td>
</tr>
<tr>
<td>Express Tools</td>
<td>Contains AutoCAD Land Desktop support tools and utilities (not supported by Autodesk).</td>
</tr>
<tr>
<td>Fonts</td>
<td>Contains AutoCAD fonts and TrueType fonts.</td>
</tr>
<tr>
<td>Autodesk Impression Toolbar</td>
<td>Allows you to quickly export any view to Autodesk Impression for advanced effects.</td>
</tr>
<tr>
<td>Content Search</td>
<td>Adds the content search functionality.</td>
</tr>
<tr>
<td>Material Library</td>
<td>The Material library contains over 300 professionally built materials to apply to your model.</td>
</tr>
<tr>
<td>New Features Workshop</td>
<td>Contains animated demos, exercises, and sample files to help users learn the</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Portable Licence Utility</td>
<td>Contains portable license management tools.</td>
</tr>
<tr>
<td>Reference Manager</td>
<td>Allows users to view and edit the paths of externally referenced files associated with a drawing.</td>
</tr>
<tr>
<td>Samples</td>
<td>Contains various feature sample files.</td>
</tr>
<tr>
<td>Tutorials</td>
<td>Contains tutorials.</td>
</tr>
<tr>
<td>VBA Support</td>
<td>Contains Microsoft Visual Basic for Applications support files.</td>
</tr>
</tbody>
</table>

- **Product Install Path** - Specifies the drive and location where AutoCAD Land Desktop will be installed.
- **Create a Desktop Shortcut** - Choose whether to display the AutoCAD Land Desktop shortcut icon on your desktop. A product icon is displayed on your desktop by default.

9. Click another product tab to configure another product, or Next and then Configuration Complete to return to the Review - Configure - Install page. Then, click Install.
   **Note** If you want a printed copy of your configuration settings, click the Print button.

10. On the Installation Complete page, choose from the following:

    View the installation log file
If you want to view the installation log file, its location is displayed.

View the AutoCAD Land Desktop Readme

The *Readme* file is opened from this page when you click Finish. This file contains information that was unavailable when the AutoCAD Land Desktop 2009 documentation was prepared.

*Note* You can also view the *Readme* file after you have installed AutoCAD Land Desktop.

11. Click Finish.

You have successfully installed AutoCAD Land Desktop. You are now ready to register your product and start using the program. To register the product, start AutoCAD Land Desktop and follow the on-screen instructions.

*Note* Autodesk does not recommend or support the distribution of an Autodesk product using imaging software. However, if you plan to use this method of distribution, please review the instructions detailed in [Distribute the Product Using Imaging Software](#) in the *Network Administrator’s Guide*.

Please send us your comment about this page
The first time you start AutoCAD Land Desktop, the Product Activation wizard is displayed. You can either activate AutoCAD Land Desktop at that time or run AutoCAD Land Desktop and activate it later. Until you register and enter a valid activation code for AutoCAD Land Desktop, you are operating the program in *trial mode* and the Product Activation wizard is displayed for 30 days from the first time that you run the program. If after 30 days of running AutoCAD Land Desktop in trial mode you have not registered and provided a valid activation code, your only option is to register and activate AutoCAD Land Desktop. Once you register and activate AutoCAD Land Desktop, the Product Activation wizard is no longer displayed.

The fastest and most reliable way to register and activate your product is by using the Internet. Simply enter your registration information and send it to Autodesk over the Internet. Once you submit your information, registration and activation occur almost instantly.

**To register and activate AutoCAD Land Desktop**

1. Click Start menu (Windows) ➤ All Programs (or Programs) ➤ Autodesk ➤ AutoCAD Land Desktop 2009 ➤ AutoCAD Land Desktop 2009.

2. In the AutoCAD Land Desktop 2009 Product Activation wizard, select Activate the Product, and then click Next.

   This starts the Register Today process.

3. Click Register and Activate (Get an Activation Code).

4. Click Next and follow the on-screen instructions.

   If you do not have Internet access, or if you want to use another method of registration, you can register and activate AutoCAD Land Desktop in one of the following ways:
Email
Create an email message with your registration information and send it to Autodesk.

Fax or Post/Mail
Enter your registration information, and fax or mail the information to Autodesk.

Please send us your comment about this page
You can add or remove AutoCAD Land Desktop features at any time. For example, you may have chosen a Custom installation option when you first installed AutoCAD Land Desktop, but now you want to add features that you did not install originally. Or you may no longer need to use all of the features that were installed originally. You can add or remove features by using the Add or Remove Programs dialog box.

**To add or remove features**

1. In Control Panel (Windows), double-click Add or Remove Programs.

2. In the Add or Remove Programs dialog box, click AutoCAD Land Desktop 2009, and then click Change/Remove.
   
   The AutoCAD Land Desktop Installation wizard re-opens in Maintenance Mode.

3. Click Add or Remove Features.

4. On the Add/Remove Features page, select a feature to install or uninstall. The icons to the left of the selections give you an indication of the action that will be taken.

   - ![Feature] Indicates a feature that was originally not installed.
   - ![Feature] Indicates a currently installed feature or a feature that you want to add.
   - ![Feature] Indicates an originally installed feature that is chosen for removal.

   **Note** If you need to revert to the AutoCAD Land Desktop features that you selected in your original installation, click Cancel.
   
   Click Next.

5. On the Update AutoCAD Land Desktop 2009 Installation page, click
Next.

6. On the Update Complete page, you are informed when the updates have been performed. Click Finish.

Please send us your comment about this page
Install Autodesk Products for an Individual User >

reinstall or Repair AutoCAD Land Desktop

If you accidentally delete or alter files that are required by AutoCAD Land Desktop, AutoCAD Land Desktop might not perform correctly, and you might receive error messages when you try to execute a command or find a file. You can attempt to fix this problem by reinstalling or repairing AutoCAD Land Desktop. The reinstallation or repair uses the features that were part of the installation type you chose when you initially installed the program.

To reinstall or repair AutoCAD Land Desktop

1. In Control Panel (Windows), double-click Add or Remove Programs.

2. In the Add or Remove Programs window, select AutoCAD Land Desktop 2009, and then click Change/Remove.
   
   The AutoCAD Land Desktop Installation wizard re-opens in Maintenance Mode.

3. Click Repair AutoCAD Land Desktop 2009.

4. On the Select Repair or Reinstall page, click one of the following, and then click Next:

   - **Repair My AutoCAD Land Desktop 2009 Installation.** This option replaces all registry entries that AutoCAD Land Desktop initially installed and restores AutoCAD Land Desktop 2009 to its default state. If you are missing AutoCAD Land Desktop files, use this option.

   - **Reinstall My AutoCAD Land Desktop 2009 Installation.** This option repairs the registry and reinstalls all files from the original installation. Use this option if the Repair My AutoCAD Land Desktop 2009 Installation option does not solve the problem.
5. On the Repair AutoCAD Land Desktop 2009 page, click Next to start the process.

6. On the Repair Complete page, you are informed when the repairs have been performed. Click Finish.

Please send us your comment about this page
When you uninstall AutoCAD Land Desktop, all components are removed. This means that even if you've previously added or removed components, or if you've reinstalled or repaired AutoCAD Land Desktop, the uninstall removes all AutoCAD Land Desktop installation files from your system.

**To uninstall AutoCAD Land Desktop**

1. In Control Panel (Windows), click Add or Remove Programs.
2. In the Add or Remove Programs window, select AutoCAD Land Desktop 2009, and then click Change/Remove.
3. Click Uninstall.
4. On the Uninstall AutoCAD Land Desktop 2009 page, click Next to remove AutoCAD Land Desktop from the system.
5. When informed that the product has been successfully uninstalled, click Finish.

**Note** Even though AutoCAD Land Desktop is removed from your system, the software license remains. If you reinstall AutoCAD Land Desktop at some future time, you will not have to register and re-activate the program.

Please send us your comment about this page
Autodesk Design Review is a tool for reviewing and working with DWF files. DWF files are drawing files that have been converted so they can be transported over the Internet and then shared with others. In order to work with DWF files, you need to have Autodesk Design Review installed.

If you want to use any of the following commands or functions with a DWF file, you need to have Autodesk Design Review installed.

- PUBLISH
- PLOT
- 3DDWF
- PUBLISH TO WEB
- EXPORT
- MARKUP
- DWFUNDERLAY
- AUTOPUBLISH
- SSM
This chapter provides solutions to installation issues and answers to commonly asked questions that may arise while installing Autodesk products.

**Topics in this section**

- General Installation Issues
- Deployment Issues
- Licensing Issues
- Networking Issues
- Uninstall and Maintenance Issues

Please send us your comment about this page
This section outlines common issues and their solutions that may arise while performing a general install of your product(s).

**Topics in this section**

- How can I check my graphics card driver to see if it needs to be updated?
- What is the text editor used for?
- What are Express Tools?
- When performing a Typical installation, what gets installed?
- Why should I install the Materials Library?
- Where are my product manuals?
How can I check my graphics card driver to see if it needs to be updated?

It is recommended that you verify and update your graphic card driver to optimize your program.

**To identify your graphics card driver**

1. Start AutoCAD Land Desktop.
2. At the command line, enter `3dconfig`.
3. In the Adaptive Degradation and Performance Tuning dialog box, click View Tune Log.
4. Review the 3D Device section for information about your system's graphics card driver and driver version.

**Tip** Many new graphics cards offer tabbed pages where you can learn more about your specific graphics card. If specific tab pages are present, refer to them instead of the Adapter tab.
What is the text editor used for?

The text editor you designate during installation is used for editing text files such as PGP and CUS dictionary files while you are running your product.
What are Express Tools?

Express Tools is a library of productivity tools that extend the power of AutoCAD Land Desktop.
When performing a Typical installation, what gets installed?

A typical installation includes the following features:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAD Standards</td>
<td>Contains tools for reviewing design files for compliance with your standards.</td>
</tr>
<tr>
<td>Database</td>
<td>Contains database access tools.</td>
</tr>
<tr>
<td>Dictionaries</td>
<td>Contains multilanguage dictionaries.</td>
</tr>
<tr>
<td>Drawing Encryption</td>
<td>Allows you to use the Security Options dialog box to protect a drawing with a password.</td>
</tr>
<tr>
<td>Express Tools</td>
<td>Contains AutoCAD Land Desktop support tools and utilities.</td>
</tr>
<tr>
<td>Fonts</td>
<td>Contains program fonts. (True Type fonts are automatically installed with the</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Autodesk Impression Toolbar</td>
<td>Allows you to quickly export any view to Autodesk Impression for advanced line effects.</td>
</tr>
<tr>
<td>Content Search</td>
<td>Adds the content search functionality.</td>
</tr>
<tr>
<td>New Features Workshop</td>
<td>Contains animated demos, exercises, and sample files to help you learn new AutoCAD features.</td>
</tr>
<tr>
<td>Portable License Utility</td>
<td>Contains portable license management tools.</td>
</tr>
<tr>
<td>Reference Manager</td>
<td>Allows you to view and edit the paths of externally referenced files associated with a drawing.</td>
</tr>
<tr>
<td>Samples</td>
<td>Contains various feature sample files (AutoCAD samples and DesignCenter Samples).</td>
</tr>
<tr>
<td>VBA Support</td>
<td>Contains Microsoft Visual Basic for Applications support files.</td>
</tr>
</tbody>
</table>
Please send us your comment about this page
Why should I install the Materials Library?

The Materials Library contains over 300 professionally made materials that you can immediately apply to objects in your model. They can also act as a basis for custom materials that you want to create.

See Materials and Textures in the AutoCAD User’s Guide.
All documentation created for Autodesk products is built in two different formats: PDF and CHM.

- PDF files are made available during installation; click the Documentation link in the installer.
- CHM files are available after the product is installed; they are accessed in the Help system in the product.

The entire content of the PDF files is available from within your installed product’s Help system.

Files are also installed to the \AutoCAD Land Desktop\Help folder.

Please send us your comment about this page
This section outlines common issues and their solutions with regards to software deployments.

Topics in this section

- Is there a checklist I can refer to when performing a deployment?
- Where should deployments be located?
- What are the default search paths and file location settings?
- Along with defining search paths and file location, can files be added?
- Where can I check if service packs are available for my software?
- How do I extract an MSP file?
- Can Online Resource settings be modified later?
- Where can I learn about InfoCenter?
- What are information channels?
- What are the benefits to enabling CAD Manager Channels?
- What are RSS feeds and how do they benefit my installation?
- Where can I learn about InfoCenter search locations?
- How do I set or customize search locations?
- What is the Working Projects folder?
- What is the Project Templates folder?
- What is the Data folder?
Is there a checklist I can refer to when performing a deployment?

The *Network Administrator Guide* contains a complete section that describes preliminary actions and the entire deployment process. See [preliminary tasks for a network deployment](#).

---

Please send us your comment about this page
**Where should deployments be located?**

*Shared folders* are required for both network license and multi-seat stand-alone methods of installation. Shared folders are the locations where product deployments are stored. Before you run the Installation wizard, create a shared folder (*network share*) on the desktop of the system where you want to store the deployments. Deployments is the recommended name for this folder. Add subfolders to the shared *Deployments* folder for each product that you plan to deploy.

Any subfolders that are placed inside a shared folder are automatically shared.

**Tip** You must have Full Control permissions set for your shared folder when you are creating your deployment images. Read permissions are necessary to access the network share and administrative permissions on the workstation where the program is deployed.
What are the default search paths and file location settings?

Support file locations are automatically set during the installation process. Support files include drivers, menus, and optional, user-defined settings such as dictionary and customization files. Predefined paths are specified for the support files.

<table>
<thead>
<tr>
<th>Support File Search Path</th>
<th>Specifies the folders in which the program should look for text fonts, customization files, plug-ins, drawings to insert, linetypes, and hatch patterns that are not in the current folder.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customization Files</td>
<td>Specifies the names and locations of various types of files.</td>
</tr>
<tr>
<td><strong>Main Customization File:</strong></td>
<td>Specifies the default location of the main customization file (<a href="#">acad.cui</a>).</td>
</tr>
<tr>
<td><strong>Enterprise Customization File:</strong></td>
<td>Specifies the location of an enterprise customization file.</td>
</tr>
<tr>
<td><strong>Custom Icon Location:</strong></td>
<td>Specifies the location for custom icons used in customization files.</td>
</tr>
<tr>
<td>Dictionary and Font Files</td>
<td>Specifies a number of optional</td>
</tr>
</tbody>
</table>
settings.

**Custom Dictionary File:**
Specifies a custom dictionary to use (if you have one).

**Alternate Font File:**
Specifies the location of the font file to use if the original font cannot be located and an alternate font is not specified in the font mapping file.

**Font Mapping File:**
Specifies the location of the file that defines how to convert fonts that cannot be found.

<table>
<thead>
<tr>
<th>Printer Support File Path</th>
<th>Specifies search path settings for printer support files.</th>
</tr>
</thead>
</table>

**Printer Configuration Search Path:**
Specifies the path for printer configuration files (PC3 files).

**Printer Description File Search Path:**
Specifies the path for files with a `.pmp` file extension, or printer description files.

**Plot Style Table Search Path:**
Specifies the path for files with an `.stb` or `.ctb` extension, or plot style table files (both named plot style tables and color-dependent plot style tables).
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic Save File Location</td>
<td>Specifies the path for the file created when you select Automatic Save on the Open and Save tab.</td>
</tr>
<tr>
<td>Color Book Locations</td>
<td>Specifies the path for color book files that can be used when specifying colors in the Select Color dialog box. You can define multiple folders for each path specified. This option is saved with the user profile.</td>
</tr>
<tr>
<td>Data Sources Location</td>
<td>Specifies the path for database source files. Changes to this setting do not take effect until you close and restart the program.</td>
</tr>
<tr>
<td>Template Settings</td>
<td>Specifies the drawing template settings.</td>
</tr>
<tr>
<td><strong>Drawing Template File Location:</strong></td>
<td>Specifies the path to locate drawing template files used by the Start Up wizard and New dialog box.</td>
</tr>
<tr>
<td><strong>Sheet Set Template File Location:</strong></td>
<td>Specifies the path to locate sheet set template files used by the Create Sheet Set wizard.</td>
</tr>
<tr>
<td><strong>Default Template File Name for QNEW:</strong></td>
<td>Specifies the drawing template file used by the QNEW command.</td>
</tr>
<tr>
<td><strong>Default Template for Sheet Creation and Page Setup Overrides:</strong></td>
<td></td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Specifies the default template file that is used for</td>
<td></td>
</tr>
<tr>
<td>creating new sheets and for storing page setup</td>
<td></td>
</tr>
<tr>
<td>overrides that can be applied to Publish operations from the</td>
<td></td>
</tr>
<tr>
<td>Sheet Set Manager.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Tool Palette File Locations</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifies the path for tool</td>
</tr>
<tr>
<td>palette support files.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Log File Locations</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifies the path for</td>
</tr>
<tr>
<td>the log file created</td>
</tr>
<tr>
<td>when you select Maintain</td>
</tr>
<tr>
<td>a Log File on the Open</td>
</tr>
<tr>
<td>and Save tab.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Plot and Publish Log File Location</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifies the path for the log file</td>
</tr>
<tr>
<td>that is created if you select the</td>
</tr>
<tr>
<td>Automatically Save Plot and Publish</td>
</tr>
<tr>
<td>Log option on the Plot and Publish</td>
</tr>
<tr>
<td>tab of the OPTION command.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Temporary Drawing File Location</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifies the location to store</td>
</tr>
<tr>
<td>temporary files. This program creates</td>
</tr>
<tr>
<td>temporary files and then deletes</td>
</tr>
<tr>
<td>them when you exit the program. If</td>
</tr>
<tr>
<td>you plan to run the program from a</td>
</tr>
<tr>
<td>write-protected folder (for example,</td>
</tr>
<tr>
<td>if you are working on a network or</td>
</tr>
<tr>
<td>opening files from a CD), specify an</td>
</tr>
<tr>
<td>alternate location for your temporary</td>
</tr>
</tbody>
</table>
| files. The folder you
<table>
<thead>
<tr>
<th>Specify must not be write-protected.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Temporary External Reference File Location</strong></td>
</tr>
<tr>
<td><strong>Texture Maps Search Path</strong></td>
</tr>
<tr>
<td><strong>i-drop Associated File Location</strong></td>
</tr>
</tbody>
</table>

Please send us your comment about this page
Along with defining search paths and file location, can files be added?

Using the Add button, you can set paths to folders where files are stored. You cannot add specific files.
Installation Troubleshooting > Deployment Issues >

Where can I check if service packs are available for my software?

To find out if a patch or Service Pack is available for your product, visit the Autodesk Product Support page at http://support.autodesk.com/.

Please send us your comment about this page
How do I extract an MSP file?

A Microsoft Patch (MSP) file is usually contained in a Service Pack executable that you download from the Autodesk Product Support website. To extract the MSP file from the executable, run the patch program from the Windows command prompt using the /e switch.

Pay particular attention to the location where the files are extracted. For details about using the patch file, review the Readme file for that patch.

Please send us your comment about this page
Can Online Resource settings be modified later?

Yes. If you want to change the state of online resources after a product is installed, you can do that from the CAD Manager Control utility. The CAD Manager Control utility is installed separately from AutoCAD Land Desktop.

From the Installation wizard, select Install Tools and Utilities and then select the CAD Manager Control utility. After installation is complete, you can start the utility from the Start menu (Windows). Click All Programs (or Programs) ➤ Autodesk ➤ CAD Manager Tools ➤ CAD Manager Control Utility.
You can use InfoCenter to enter a question for help, display the Communication Center panel for product updates and announcements, or display the Favorites panel to access saved topics. For more information, refer to Search For And Receive Information in the AutoCAD User’s Guide.
What are information channels?

The Communication Center component of InfoCenter allows you to receive announcements from various information channels. Through information channels, you can receive the following:

- Product Support information, including maintenance patch notifications.
- Subscription Center announcements and subscription program news, as well as links to e-Learning Lessons, if you are an Autodesk subscription member.
- Notifications of new articles and tips posted on Autodesk websites.

Please send us your comment about this page
What are the benefits to enabling CAD Manager Channels?

CAD Manager Channels allow access to Internet-based content and information feeds from a specified feed location.
What are RSS feeds and how do they benefit my installation?

An RSS feed is a live link you initiate by subscribing to someone’s website. Once subscribed, the primary benefit is a constantly updating stream of content that is delivered to your system in the form of summarized articles, forum threads, blog posts, and so on. RSS stands for Rich Site Summary (or Really Simple Syndication).

Please send us your comment about this page
You can use InfoCenter to search multiple sources (for example, Help and specified files) at one time, or choose to search a single file or location.

See Search for Information in the *AutoCAD User’s Guide*.
How do I set or customize search locations?

InfoCenter Search and Communication Center settings can be set in the InfoCenter Settings dialog box or in the CAD Manager Control utility. You must use the CAD Manager Control utility to specify CAD Manager Channel settings. See Specify InfoCenter Settings in the *AutoCAD User’s Guide*. 

Please send us your comment about this page
What is the Working Projects folder?

The Working Projects folder is a location where you work with your project data.

Please send us your comment about this page
What is the Project Templates folder?

The Project Templates folder contains a predetermined folder structure that can be used for your new projects. When a new project is created, you can specify to use a project template, and the new project will inherit a folder structure defined in the Project Template folder.
What is the Data folder?

The Data folder contains items such as preview drawings, quantities reports style sheets, layer and corridor standards, and others.
This section outlines common issues and their solutions with regards to software licenses and licensing your product(s).

**Topics in this section**

- What is the difference between a stand-alone license and a network license?
- What is the benefit to using a network licensed version of the software?
- What is Internet Explorer used for?
What is the difference between a stand-alone license and a network license?

Stand-alone licensed products are registered and activated to an individual workstation. While the software can be installed on multiple systems in your facility, the license only allows one system to be operational. The Portable License Utility can be used if a license needs to be transferred to another system. If you need to run more systems, you need to purchase more stand-alone licensed products, or consider converting to network licenses.

Network licensed products rely on the Network License Manager to keep track of software licenses. The software can be installed and run on multiple systems, up to the maximum number of licenses you’ve purchased. The Network License Manager “checks out” licenses until they are all in use. No further systems can run the program until a license is “checked in.” If you need to run more systems, you can purchase additional licenses for the Network License Manager to maintain.
What is the benefit to using a network licensed version of the software?

Network licensed products are recommended for large drafting/design facilities, classrooms, and lab environments. The main advantage is that you can install products on more systems than the number of licenses you have purchased (for example, purchasing 25 licenses but installing on 40 workstations). At any one time, products will run on the maximum number of systems for which you have licenses. This means you get a true floating license. If software needs to be run on more systems, additional licenses can be purchased.

Registration and activation occurs only once and the licenses are maintained on your Network License Server.
After installing your product, you can operate in *trial mode* for a given number of days. Whenever you launch the program, you are prompted to activate the software. When you choose to activate the software, Internet Explorer makes this process much faster. Once you entered your registration data and submit it to Autodesk, an activation code is returned and you are not prompted again during startup.

---

**Please send us your comment about this page**
This section outlines common issues and their solutions with regards to performing a network installation or configuring your network license server(s).

**Topics in this section**

- When installing tools and utilities, which selections are applicable for a multi-seat stand-alone installation?
- When installing tools and utilities, which selections are applicable for a stand-alone installation?
- Where do I find my server name?
- What information does the log file contain?
- When specifying user workstation settings, I am given the option to specify a profile. What are profiles?
- Can I create custom desktop shortcuts?
- What happens when you choose to append or merge service packs?
- What is an administrative image (MSI) file?
- What is the impact of selecting all products to be included in the administrative image?

Please send us your comment about this page
When installing tools and utilities, which selections are applicable for a multi-seat stand-alone installation?

Since a multi-seat stand-alone licensed product does not rely upon a license server to manage or activate the license, the only tool that is beneficial is the Autodesk CAD Manager tool.

You need the CAD Manager tool if you want to make changes to CAD Manager Channels.

Please send us your comment about this page
When installing tools and utilities, which selections are applicable for a stand-alone installation?

The Autodesk CAD Manager tool is the only tool that is beneficial to a stand-alone licensed product. With the CAD Manager tool, you can modify CAD Manager Channels.
When installing a network licensed product, you must specify the name of the server that will run the Network License Manager. If you don’t know the server name, you can quickly find it by opening a Windows command prompt on the system that will be the Network License Manager. At the prompt, enter `ipconfig /all` and note the Host Name entry.

Please send us your comment about this page
What information does the log file contain?

There are two types of log files that can be generated that monitor information about deployments and installations.

The Network log file keeps a record of all workstations that run the deployment. The log lists the user name, workstation name, and the status of the installation. Refer to this file for status information and details about problems that users may have encountered during installation.

The Client log file contains detailed installation information for each workstation. This information may be useful in diagnosing installation problems. The client log is located in the \Temp directory of each client workstation.
When specifying user workstation settings, I am given the option to specify a profile. What are profiles?

Profiles are created on the Profiles tab of the Options dialog box. Profiles can contain configuration settings for just about anything that is not a drawing based system variable. For example, a profile can contain things like support paths, grip settings, and plot settings.

When you specify a profile on the Specify User Preferences page during the deployment process, it ensures that all workstations that use that deployment to install the product will be configured the same way.

Please send us your comment about this page
You can choose to create custom desktop shortcuts that use command line switches to specify several options when you start the program. For example, command line switches can be set to run a script during program launch, create a drawing based on a template or prototype drawing, or designate a workspace that should be restored on startup.

For more information, see Customize Startup in the *AutoCAD User’s Guide*. 

**Please send us your comment about this page**
What happens when you choose to append or merge service packs?

When you append a service pack, the service pack is applied to the current deployment only. Multiple service packs may be appended to a deployment. The service pack file is included in the deployment and the service pack is applied after the product is deployed.

When you merge a service pack, the service pack is merged into the administrative image. Once merged, a service pack may not be removed from the administrative image. Multiple service packs may be included in a single administrative image.

You can choose to append or merge service packs from the Include Service Packs page when creating a deployment.

Please send us your comment about this page
What is an administrative image (MSI) file?

An *administrative image* is a collection of shared file resources created during the deployment process and is used by deployments to install the program to networked workstations. Service packs (patches) can be applied to an administrative image when you create the deployment. An `.msi` file is a Microsoft Installer file.
What is the impact of selecting all products to be included in the administrative image?

If you elect to include all products in your deployment, the administrative image will be larger. You should select all products only when you create multiple deployments from this image and prefer not to use the installation disk. If there are products you rarely or never use, and you do not expect to create additional deployments, you should only select a subset of products.

You can still create a deployment at a later date, and include additional products, but you need to create a new administrative image. You need the installation media to do so.
This section outlines common issues and their solutions with regards to adding and removing features, reinstalling or repairing your installation, and uninstalling products.

**Topics in this section**

- **When adding or removing features, how can I tell what features get installed by default?**
- **Is it possible to change the installation folder when adding or removing features?**
- **When should I reinstall the product instead of a repair?**
- **Do I need my original disk to reinstall my software?**
- **After repairing my installation, is it possible to recover my settings?**
- **When I uninstall my software, what files are left on my system?**

Please send us your comment about this page
When adding or removing features, how can I tell what features get installed by default?

To quickly see what gets installed during a typical, default installation, click the Restore Defaults button on the Add/Remove Features page.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAD Standards</td>
<td>Contains tools for reviewing design files for compliance with your standards.</td>
</tr>
<tr>
<td>Database</td>
<td>Contains database access tools.</td>
</tr>
<tr>
<td>Dictionaries</td>
<td>Contains multilanguage dictionaries.</td>
</tr>
<tr>
<td>Drawing Encryption</td>
<td>Allows you to use the Security Options dialog box to protect a drawing with a password.</td>
</tr>
<tr>
<td>Express Tools</td>
<td>Contains AutoCAD Land Desktop support tools and utilities.</td>
</tr>
<tr>
<td>Fonts</td>
<td>Contains program fonts. (True Type fonts are</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Autodesk Impression Toolbar</td>
<td>Allows you to export any view to Autodesk Impression for advanced line effects.</td>
</tr>
<tr>
<td>Content Search</td>
<td>Adds the content search functionality.</td>
</tr>
<tr>
<td>New Features Workshop</td>
<td>Contains animated demos, exercises, and sample files to help users learn new features.</td>
</tr>
<tr>
<td>Portable License Utility</td>
<td>Contains portable license management tools.</td>
</tr>
<tr>
<td>Reference Manager</td>
<td>Allows you to view and edit the paths of externally referenced files associated with a drawing.</td>
</tr>
<tr>
<td>Samples</td>
<td>Contains various feature sample files.</td>
</tr>
<tr>
<td>VBA Support</td>
<td>Contains Microsoft Visual Basic for Applications support files.</td>
</tr>
</tbody>
</table>
Please send us your comment about this page
Is it possible to change the installation folder when adding or removing features?

Once your product is installed, you cannot change the installation path from the Add/Remove Features page. Changing the path while adding features results in program corruption, so it is not an option.

Please send us your comment about this page
You should reinstall your product if you accidentally delete or alter files that are required by the program. Missing or altered files adversely affect the performance of your product and cause error messages when you try to execute a command or find a file.

If an attempt to repair an installation fails, reinstalling is the next best option.
Do I need my original disk to reinstall my software?

When performing a reinstall of the product, you do not need to have the original DVD. Installation data is cached locally on your drive and that data is reused when reinstalling.
After repairing my installation, is it possible to recover my settings?

Custom settings can be exported and later re-imported to the same system in case you have to repair the installation of your program.

For more detailed information regarding exporting and importing custom settings, see Export and Import Custom Settings from the Same Release.
When I uninstall my software, what files are left on my system?

If you uninstall the product, some files remain on your system such as files you created or edited (drawings or custom menus).

Your license file also stays on your workstation when you uninstall your product. If you reinstall on the same workstation, the license information remains valid and you do not have to reactivate the product.